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1. Introduction

1.1 Overview

The CY3218-CAPEXP2 CapSense® Express™ Evaluation Kit is used to evaluate the CapSense
Express device. This kit demonstrates the following features: CapSense buttons, LED drive, digital
input, and I2C. The CapSense Express device is configured via a system-level project in PSoC®
Designer™. A 16-pin QFN package device is mounted on the board. The board is powered with a
AAA battery. A boost converter converts the input, in the range of 1.1 V to 1.5 V, to the device
operating voltage of 3.3 V. The board can also be powered using the CY3240-I2USB bridge
connected to the I2C header. 

1.2 Kit Contents

The CY3218-CAPEXP2 CapSense Express Evaluation Kit includes:

■ CY3218-CAPEXP2 CapSense Express Evaluation Board

■ CY3240-I2USB Bridge Board

■ USB A to Mini-B cable

■ AAA battery

■ 1 mm acrylic overlay 

■ Quick Start Guide

■ Kit CD, which includes 

❐ PSoC Designer IDE

❐ Bridge Control Panel software

❐ CapSense Express datasheets 

❐ Kit release notes 

❐ Kit user guide

❐ Software release notes 

❐ Code example documentation

❐ Hardware design files

❐ Sample silicon CY8C201A0-LDX2I (5 numbers)

1.3 Default Jumper Settings

Jumper (J2) on the CY3218-CAPEXP2 CapSense Express Evaluation Kit board configures the
power setting for the board.

■ Default position for J2: Jumper on pin 1 and 2; this enables powering the board via the CY3240-
I2USB bridge.

■ To power the board via battery, remove the jumper at J2.
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1.4 Additional Resources

Visit http://www.cypress.com for additional learning resources in the form of datasheets, technical
reference manual, and application notes.

■ Getting Started with CapSense

This guide is an ideal starting point for those new to capacitive touch sensing (CapSense) as well as
for learning key design considerations and layout best practices to ensure design success.

1.5 Documentation Conventions

Table 1-1.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

http://www.cypress.com
http://www.cypress.com/?rID=48787
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2. Getting Started

2.1 Hardware

The following figure illustrates the CY3218-CAPEXP2 CapSense Express Evaluation Kit board
features.

Figure 2-1 shows the block diagram of the CY3218-CAPEXP2 CapSense Express Evaluation Kit.
The block diagram has two main sections, power supply and CapSense controller. The power supply
section is based on the onboard battery power. The 1.5 V battery voltage is converted into 3.3 V with
boost converter because the CapSense controller does not work below 2.4 V. The connector J2 pro-
vides an option to power the kit from the onboard battery or an external power source, which must
be connected to the J5 connector. An LED indicates the power status of the kit.

A five-segment CapSense-based slider indicates the positional values using the four LEDs con-
nected to the GPIOs of CapSense Express. A mechanical switch, which demonstrates the capability
of CapSense Express to read the status of external signals, is also provided with the kit. The
CapSense Express controller can be configured and controlled through the I2C interface; therefore,
a 5-pin header is provided for the I2C interface.

Top View                              Bottom View

Status LEDs

Mechanical Button

CapSense Slider Power Selection Jumper (J2)

Power LED CapSense Express 

AAA Battery Holder (J1)

I2C Header (J5)
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Figure 2-1.  CY3218-CAPEXP2 CapSense Express Evaluation Kit Block Diagram

2.1.1 Power Supply System

The CY8C201A0 chip is a low-power CapSense Express Controller, which can be powered from a
single 1.5 V AAA battery. The CapSense Express controller can work only from 2.4 V to 5.5 V power
supply; therefore, a boost converter is used in the kit to generate the 3.3 V power supply required
from the 1.5 V battery. 

Figure 2-2.  Power Supply System

The jumper J2 provides power on/off control for the kit. When the jumper is inserted, the Enable
Input (EN) pin of the boost converter is connected to ground, which cuts off power to the kit. Remov-
ing the jumper J2 connects the EN pin to VDD, to power the kit. The LED turns on when the kit is
powered.

Onboard
Battery

External Power
Supply through
Connector J5

Power Supply
Selection through

Jumper J2

Power
Indicator
LED

Boost Converter

CY8C201A0
CapSense Controller
(Demonstration)

Five Segment
Slider

Mechanical
Switch Input
through S1

Four Status
LEDs

5-Pin I2C
Header
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2.1.2 Slider and Mechanical Button

Figure 2-3.  Input Schematic (Slider and Mechanical Button)

Figure 2-4.  LED Schematic

2.1.3 CapSense Controller

The CapSense Express controller chip is connected to two input sections and one output section.
The five-segment slider and mechanical button provides input to the chip through the I2C interface.
The output is provided through the status LEDs, which turn green. The mechanical button also pro-
vides the signal with mechanical on/off similar to the slider.
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Figure 2-5.  CapSense Controller Schematic

2.1.4 I2C Interface

The CY3218-CAPEXP2 CapSense Express Evaluation Kit has the 5-pin header J5 for I2C interface.
The I2C interface is used to connect the CapSense controller with the host system to monitor the
sensor status and configure the CapSense controller according to system requirements. The sensor
is also tuned during the design stage using the I2C interface and the CY3240-I2USB Bridge tool.

I2C communication needs pull-up resistors, both SCL and SDA signals, on the master or slave side.
The kit hardware has footprints R13 and R15 (no-load components by default) to populate pull-up
resistors if they are not available on the master side.

The CapSense Express controller supports 50 kHz, 100 kHz, and 400 kHz data transfer speed for
the I2C interface.  

Figure 2-6.  I2C Interface Schematic
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3. Installation

3.1 Install Hardware

CAUTION  Make sure you do not touch the board anywhere other than the edges or on the buttons.
Touching the board in the wrong area can lead to a short and an unresponsive board. If this hap-
pens, reset power to the board. To do this, disconnect the battery supply by placing the jumper on
J2. To power the board again, remove the jumper from J2. 

The CY3218-CAPEXP2 CapSense Express Evaluation Kit is preprogrammed with demonstration
firmware. These instructions assume that your board is not reconfigured from the factory settings. If
it has, follow the instructions given in Create Project with CY3218-CAPEXP2 on page 21 to config-
ure the board.

1. Unpack the CY3218-CAPEXP2 CapSense Express Evaluation Kit.

2. Insert the AAA battery into the battery holder.

3. Remove the jumper from J2 (back, left, and center of board). 

4. Observe that the status LED D5 flashes and the red LED, D1, on the back of the board lights up.

5. Slide a finger over the CapSense slider to light the LEDs D2, D3 and D4. Also, the status LED D5 
stops blinking while the slider is used.

6. Turn the board off by replacing the jumper on J2. Note that replacing the jumper disables battery 
operation.

3.2 Install Software
Install the software required to load and run the code examples.

3.2.1 Before You Begin

All Cypress software installations require administrator privileges, but this is not required to run the
installed software. 

1. Shut down all Cypress software that is currently running. 

2. Disconnect ICE-Cube or MiniProg1 devices from your computer. 

Note that CapSense Express runs on an older version of PSoC Designer (PD5.0). Therefore, both
versions of PSoC Designer are required - PD5.0 for CapSense Express and PD5.1 for all other
devices.

3.2.2 Installing Software

To use the CY3218-CAPEXP2 CapSense Express Evaluation Kit, you need:

■ PSoC Designer 5.0 SP6

■ PSoC Programmer 3.13.3 or later 

■ Bridge Control Panel 1.3 or later (packaged with PSoC Programmer)
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If PSoC Designer (versions older than PD5.0 SP6), PSoC Programmer (versions older than
PP3.13.3), and Bridge Control Panel (versions older than BCP1.3) are currently installed, uninstall
the same before reinstalling. To uninstall, go to Start > Control Panel > Add or Remove Programs
and click the Remove button adjacent to the particular software. Follow the instructions to uninstall.

Follow these steps to install the software:

1. Insert the kit CD/DVD into your PC's CD/DVD-ROM drive. Click Install PSoC Programmer 
3.13.3… on the installation startup screen.

2. Wait for the installer to copy all the necessary files to a temporary folder.



CY3218-CAPEXP2 CapSense® Express™ Evaluation Kit Guide, Doc. # 001-54703 Rev. *D 13

Installation

3. Click Next to install in the default location. To change the location, click the Change button.

4. Wait for the installation to complete.
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5. The CyInstaller window for PSoC Programmer is displayed when the installer is ready. Select 
Typical in the Installation Type options list and click Next to proceed.

6. Read the Software License Agreement and select I accept the terms in the license agreement; 
click the Next button.
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7. Wait for the installation to complete.

8. Click Finish to complete the installation. Select the View Release Notes option to open the 
release notes after the installer window closes.
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9. Click Install PSoC Designer 5.0… in the installer startup screen.

Note If the installer does not start automatically, start it manually by executing cyautorun.exe in 
the CD/DVD's root directory.

10.Wait for the installer to copy all the necessary files to a temporary folder.
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11.Read the Software License Agreement and select I accept the terms of the license agreement; 
click the Next button.

12.Click Next to proceed with the Installation.
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13.Click Next to install in the default location. To customize the install location, click on the Browse 
button and navigate to the respective directory.

14.Review the settings before starting the installation. Click Back to change the settings, if required. 
Otherwise, click Next to start the installation.
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15.Wait for the PSoC Designer 5.0 installation to complete.

16.Click Yes if you want a shortcut to PSoC Designer on your desktop; click No to continue with the 
installation.

17.Click Finish to complete the installation. Select the View Release Notes option to open the 
Release Notes after completing the installation.
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3.2.2.1 PSoC Designer Overview

PSoC Designer is the revolutionary integrated design environment (IDE) that helps you to customize
PSoC to meet your specific application requirements. PSoC Designer accelerates system bring-up
and time-to-market. Develop your applications using a library of pre-characterized analog and digital
peripherals in a drag-and-drop design environment. Then, customize your design leveraging the
dynamically generated API libraries of code. Finally, debug and test your designs with the integrated
debug environment including in-circuit emulation and standard software debug features. 

To open the application, click Start > All Programs > Cypress > PSoC Designer <version>>
PSoC Designer <version>.

For instructions on creating and developing firmware projects for CapSense Controller in PSoC
Designer, see the IDE User Guide.pdf available at the following location: 
<Install_directory>:\PSoC Designer\<version>\Documentation\. 
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4. Create Project with CY3218-CAPEXP2

4.1 Functional Description

The board consists of one five-segment CapSense slider and four status LEDs associated with the
slider. It also has a mechanical button. The status LEDs 1 to 3 light up when a finger is moved over
the slider. The device enters into sleep mode if no sensor or mechanical button is touched. When the
device is in sleep mode, the fourth LED toggles its state. If the device is not in sleep mode, the LED
is continuously on to indicate the same.

The completed project is available in <CD_root>:\Program\CapSenseSlider\.

The CY3240-I2USB Bridge is used to transfer the configurations done in PSoC Designer to the
PSoC device on the board. The CY8C201A0 device in this kit is an I2C communication-enabled
device for CapSense configuration, reading the status and data registers of the device, and so on.
See the device datasheet for more details.

The I2USB Bridge is used to monitor and tune the CapSense parameters; these parameters can be
transferred to the device from the GUI through the I2USB Bridge without reprogramming the device.

4.2 Create New Project
1. Connect your computer to the CapSense test board I2C connector (J5) using the CY3240-I2USB 

Bridge and a USB cable, as shown in Figure 4-1.

Figure 4-1.  CY3240-I2USB Connection to CY3218-CAPEXP2 Kit

Mini USB Port

Front of Board
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2. Ensure that the jumper J2 at the back of the board is open and the red LED, D1, is ON.

3. Launch PSoC Designer.

4. To create a new project, click on File > New Project.

5. Select the System-level Project icon in Project types; name the project 'CapSenseSlider' and 
save it to a location of your choice on the computer. 

6. Select View > All Driver Catalogs and then select the Inputs tab. Open CapSense Express > 
CY8C201A0, right-click the 5 Segment Slider driver, and select Add to Design. The Add Input 
Driver window opens.
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7. Name the driver ‘Slider’ and click OK. The CapSense Express 5 Segment Slider opens.

8. In the system-level project, the CapSense slider, LED, and the mechanical button require a sepa-
rate driver. The ‘5 GPIO/CS Button’ driver is a special driver that allows you to configure all the 
buttons, LEDs, and the mechanical button in one interface. Each driver is listed in the Configure 
Local Parameters pane.
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4.3 Configure the Driver

By default, all driver types in the Configure Local Parameters pane are set to CapSense Input. To set
up the LEDs, set the Pin Type for C0 through C3 to GPOutput and the Drive Mode to Strong Drive.
To set up the mechanical button, set the Pin Type for C4 to GPInput and the Drive Mode to Resis-
tive Pull Up. Set the IDAC setting to 30 for all slider sensors.

4.4 Configure Button and LED Behavior
1. In the Pin Specific Tuning pane, choose G0 from the Select Pin menu.

2. Click on the yellow box of the CapSense slider segment you want to assign to LED G0. For LED 
output pin G0, select the CapSense sensor Sldr0. A small line connects Sldr0 to the purple OR 
box. To turn the LED on when the button is touched, click the small box (highlighted in the follow-
ing figure) to the right of the purple OR box. 
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3. This changes the square to an invert symbol; this is needed as the LED is connected in current 
sink mode.

4. Repeat step 1 and step 2 for drivers G1 and G2 according to the following table.

5. To have G3 LED toggled upon every wake from sleep, select G3 from drop-down menu and click 
the yellow G3 box. A small line then connects G3 to the purple OR box. Click the small box to the 
right of the purple OR box. This changes the square to an invert symbol; this is needed because 
the LED is connected in current sink mode.

LED Input 

G0 Sldr0

G1 Sldr2

G2 Sldr4
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6. The configuration of all the LEDs appear as follows.
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7. Enable the I2C Drop The Sample filter in the CapSense Filtering Specific section in the Global 
Parameters Window.
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8. Enable External Capacitor in the CapSense Specific parameters. The external capacitor is 
enabled to get higher finger response when using overlay.

9. Configure I2C related parameters in Global Parameters, as shown in the following figure.

10.Disable sleep mode in the Sleep Management section because it does not allow CapSense tun-
ing.

4.5 Pin Assignment
1. Click the Pin Assignment (16-QFN) button in the top left. The User Pin Assignment window 

opens.

2. Select 16 pin QFN as the Pin Package Type.
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3. Assign each CapSense button, LED, and mechanical button on the board to the pin annotated on 
the board. For example, the CapSense sensor in the extreme left is labeled GP0[4]. 

4. Drag each driver from the unassigned list to the appropriate pin.
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5. Click OK to close the User Pin Assignment window.

6. Click Apply to board. 

7. Wait for the Configure through USB2IIC Bridge status window to appear and click OK.

8. Click OK to close the CapSense Express 5 Segment/Slider window.

Driver Pin 

Sldr 1 (Sldr0) GP0[4]

Sldr 2 (Sldr1) GP0[3]

Sldr 3 (Sldr2) GP0[2]

Sldr 4 (Sldr3) GP1[4]

Sldr 5 (Sldr4) GP1[3]

Output1 (G0) GP1[1]

Output2 (G1) GP0[1]

Output3 (G2) GP0[0]

Output4 (G3) GP1[0]

Input3 (G4) GP1[2]



CY3218-CAPEXP2 CapSense® Express™ Evaluation Kit Guide, Doc. # 001-54703 Rev. *D 32

5. Tune CY3218-CAPEXP2

5.1 Monitor CapSense Signal

Follow these steps to monitor the CapSense signal.

1. Click Monitor to open the Monitor view.

2.  The Monitor Status indicator shows Connected.

3. Select the I2CUSB bridge power supply option.

4.  Right-click Slider and select Show Tuner.

5. The Monitor Status indicator changes to Running and the CapSense Express window opens.

6. If your board is configured with another design, click Apply to board in the lower right of the 
CapSense Express window. When the Configure through USB2IIC Bridge status dialog 
appears, click OK. If your board is already configured with the correct design, the Apply to board 
button is grayed out.
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5.2 Tune Slider
1. Select Slider from the Select Pin menu. 

2. Check the Show Difference option and touch each sensor of the slider to see the signal.

3. Reduce the IDAC setting to increase the signal strength and vice-versa. To do this, keep a finger 
on the CapSense slider sensor and reduce IDAC value until required signal is produced. In this 
example, it is set to 30 for the 1-mm acrylic overlay provided with the kit.
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4. When the slider tuning is complete, enable Normal Sleep with 125 ms sleep interval. Sleep 
Control Pin should set as mechanical button (G4) for the device to wake from sleep. Finally, set 
Stay Awake Counter to 10.

5. Hold the mechanical button pressed while applying the new setting to the board, because the 
device should not enter into sleep while configuring.

6. Verify the three LEDs representing the finger position on the slider. The G3 LED flashes with a 
period of approximately 125 ms. When the mechanical button or slider is pressed, the device 
never enters into sleep and LED is continuously on.

7. Experiment with other materials such as plastic and wood or overlay used for your product.
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6. Technical References

6.1 CY3218-CAPEXP2 Schematic 

The schematic for the CY3218-CAPEXP2 CapSense Express Evaluation Kit is available on the kit
CD/DVD:

■ PDF file: <CD_root>\Hardware\REF_14696_REVSA_Schematic.pdf

■ DSN file: <CD_root>\Hardware\REF_14696_REVSA.dsn

6.1.1 Schematic Page 1
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6.1.2 Schematic Page 2

6.1.3 Schematic Page 3
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6.1.4 Schematic Page 4
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6.2 CY3218-CAPEXP2 Board Layout 

The board layout for CY3218-CAPEXP2 CapSense Express Evaluation Kit is available on the kit
CD/DVD:

■ PDF file: <CD_root>\Hardware\PDCR_9459_REVSS_Layout.pdf

■ Board file: <CD_root>\Hardware\PDCR_9459_REVSS.brd

■ Gerber file: <CD_root>\Hardware\PDCR_9459_REVSS.zip

6.2.1 PDCR-9459 Top Layer
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6.2.2 PDCR-9459 Bottom Layer

6.2.3 PDCR-9459 Top Silk Screen
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6.2.4 PDCR-9459 Bottom Silk Screen
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6.3  CY3218-CAPEXP2 Bill of Material (BOM)

The BOM for the CY3218-CAPEXP2 CapSense Express Evaluation Kit is available on the kit CD/
DVD as an Excel file: <CD_root>\Hardware\121R_45900_REVSS_BOM.xls

Item Qty Reference Part Manufacturer Manuf. Part#

1 1 CSS1 CapSense Slider 5-Segment 10x44mm
Manufacturing Pro-
cess

2 3 C1,C3,C4 CAP CERAMIC 10.0UF 16V X5R 1206 Kemet C1206C106K4PACTU

3 6 C2,C6,C9,C10,C11,C17 CAP .10UF 10V CERAMIC X7R 0603 Kemet C0603C104K8RACTU

4 2 C7,C100 CAP NO LOAD 0603 NA NA

5 5 C12,C13,C14,C15,C16 CAP .10UF 10V CERAMIC X7R 0603 Kemet C0603C104K8RACTU

6 1 D1 LED RED CLEAR 0603 SMD
Lite-On Trading USA, 
Inc.

LTST-C190CKT

7 4 D2,D3,D4,D5 LED GREEN CLEAR 1206 SMD LITE-ON INC LTST-C150GKT

8 1 J1 CLIP BATTERY AAA/N .375X.460" SS Keystone Electronics 55

9 1 J2 CONN HEADER 2POS .100" VERT 15AU
Molex/Waldom Elec-
tronics Corp

68301-1055

10 1 J5 CONN HEADER 5POS 0.1 RA KEYED Molex 22-05-3051

11 1 L1 INDUCTOR 2.2UH 1.44A 20% 1607 SMD Taiyo Yuden / Kemet NR4018T2R2M

12 1 R1 RES 160 OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07160RL

13 4 R2,R7,R8,R41 RES CHIP 100K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07100KL

14 1 R3 RES 549K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07549KL

15 5 R4,R13,R15,R100,R101 RES NO LOAD 0603 SMD NA NA

16 1 R5 RES 560K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07560KL

17 1 R6 RES 249K OHM 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF2493V

18 2 R12,R16 RES 330 OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ331V

19 6 R17,R18,R19,R20,R21,R24 RES 560 OHM 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ561V

20 4 R32,R34,R35,R36 RES 68 OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ680V

21 1 R33 RES 10K OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ103V

22 1 S1
SWITCH TACT SEAL 7.20MMx7.20MM 
H=4.7MM 160GF SMT

E-Switch TL6120AF160QG

23 1 U1
IC SYNC BOOST CONV 1.3A SW ADJ 
10SON

Texas Instruments TPS61200DRCT

24 1 U2 nanoPSoC - Capsense Lite Family 16-QFN
Cypress Semicon-
ductor

CY8C201A0-SX2I

Special Jumper Installation Instructions

25 1 Install jumper across pins of J2
Sullins Electronics 
Corp.

STC02SYAN

Special Standoff Installation Instructions

26 4 Install standoffs with screws into holes on 
corners such that they hold the battery termi-
nals (on the bottom of the board) off the 
tabletop.

Keystone Electronics 24395

27 4 Keystone Electronics 29311
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6.4 CY3218-CAPEXP2 Pin Assignment

Pin Number Port Number Design Function

1 GP0[0] LED 4 (D3)

2 GP0[1] LED 2 (D5)

3 I2C SCL I2C clock

4 I2C SDA I2C data

5 GP1[0] LED 1 (D4)

6 GP1[1] LED 3 (D2)

7 VSS Ground connection

8 GP1[2] Mechanical button

9 GP1[4] Cap slider segment 4

10 GP0[3] Cap slider segment 2

11 XRES Active HIGH external reset with internal pull down

12 GP1[3] Cap slider segment 5

13 VDD Supply voltage (3.3 V)

14 GP0[4] Cap slider segment 1

15 CSInt Integrating capacitor input

16 GP0[2] Cap slider segment 3
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